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License agreement
EMERGING INFORMATION SYSTEMS INC. (“EISI”) 
SOFTWARE LICENSE AGREEMENT

(the “License Agreement”)

WHEREAS:

A.    EISI is the owner of and is entitled to license certain computer programs which are marketed in the aggregate 
under the NaviPlan® trademark (the “NaviPlan Software”). In addition, EISI has entered into one or more 
agreements with third parties (each a “Third Party Provider”) pursuant to which EISI is entitled to integrate 
software owned by the Third Party Providers (the “Third Party Software”) into the NaviPlan Software and to 
license same for use by clients of EISI on the terms and conditions of this License Agreement.

B.    EISI, or the duly authorized licensee or sublicensee of EISI with whom you are dealing, (the “Licensor”) is willing 
to grant you (sometimes called the “User”) a personal, non-exclusive, non-transferable license which would 
enable you to use, in accordance with and subject to the provisions of this License Agreement, either for 
evaluation during a trial period to be determined by EISI or for such longer term during which you pay the 
Licensor its required license fees, such of the NaviPlan Software, and any enhancements and updates to the 
NaviPlan Software that are made available to the User by the Licensor from time to time, and Third Party 
Software, together with the related documentation, as you agree to license (the “Licensed Software”).

C.   The licensor encourages you to read and fully understand this license agreement before deciding 
whether you are willing to be bound by it. If you have any questions, we recommend that you show 
this license agreement to your lawyer and obtain advice as to your rights and obligations before 
becoming bound by it.  If, after you fully understand the License Agreement, you decide that you are willing to 
become bound by all of its terms and conditions, please click on the location indicating “I accept the terms in the 
License Agreement” and you will then be bound by this License Agreement and, subject to payment of license 
fees when due (for licenses other than during a trial, for which no fees are payable), you will be entitled to use the 
Licensed Software. If you click the location indicating “I do not accept the terms in the License Agreement” or 
click on the “Cancel” button prior to accepting the terms of the License Agreement, you will not be entitled to use 
or be granted access to the Licensed Software and you may not copy or install the software.

THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT ARE AS FOLLOWS:

1.    The Licensor hereby grants the User a personal, non-exclusive, non-transferable license to use, in accordance 
with and subject to the provisions of this License Agreement, the Licensed Software.

2.    If the User is entitled to use the Online Version of the Licensed Software, in order to gain access to it, the User 
must log in to the Licensor’s designated Web Site using a user name and password issued by the Licensor that will 
be unique to the User (the “User ID”). It is a condition of this License Agreement that the User will keep the User 
ID confidential, will not share the User ID with anyone else and will not permit anyone other than the User to have 
access to the Licensed Software by using the User ID.

3.    If the User is entitled to install a copy of the Licensed Software in the User’s computer, regardless of whether that 
copy is downloaded from a Web Site or is provided to the User on CD ROM, the User may not rent, lend, lease, 
donate, pledge, sell, transfer, sublicense, assign or otherwise convey the Licensed Software or any copy thereof to 
another party. In addition, the User covenants and agrees with EISI that the User shall not (and shall not permit 
any employee or other third party to) copy, use, analyze, reverse engineer, decompile, disassemble, translate, 
convert or apply any procedure or process to the Licensed Software in order to ascertain, derive, and (or) 
appropriate for any purpose whatsoever, the source code or source listings for the Licensed Software or any trade 
secret information or process contained in the Licensed Software. The User is not entitled to and agrees that the 
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User will not change or cause the Licensed Software or its data structures to be changed or make any attempt to 
do so. The User shall be entitled to make a single copy of the Licensed Software for backup purposes. No other 
copies of the Licensed Software shall be made. Both copies of the Licensed Software must be kept in the User’s 
possession. If the Licensor provides the User with an updated copy of the Licensed Software, the User may use 
either the current or prior version of the Licensed Software, but never both versions at the same time.

4.   The license granted hereby is for the User, in his or her capacity as a professional financial planner, to use the 
Licensed Software to prepare financial plans for the User’s existing and prospective customers, who must be 
individuals who are endeavouring to develop a plan for their and their family’s future. This license does not entitle 
the User to use the Licensed Software for the purpose of assisting any other persons, including other financial 
planners, in the preparation of plans, unless those other persons are also licensed to use the Licensed Software.

5.   The User shall be responsible, at his or her own cost, for acquiring all computer hardware and software to enable 
him or her to use the Licensed Software.

6.    Subject to the rights of the Third Party Providers of any Third Party Software licensed to EISI, the Licensed 
Software is owned by EISI and is protected by copyright and (or) trade secret law. Under this License Agreement, 
the User acquires the right to use the Licensed Software for the limited purposes set forth in this License 
Agreement but does not acquire any rights of ownership in the Licensed Software. As between the User and EISI, 
EISI shall at all times retain all right, title and interest in the Licensed Software on its own behalf and on behalf of 
the Third Party Providers of the Third Party Software.

7.    This License Agreement comes into effect immediately upon the User’s agreeing to be bound by it and, subject to 
the User’s having paid the license fees for the Licensed Software (for licenses other than during a trial, for which 
no fees are payable), will continue in effect for the term during which you have agreed to pay and pay the 
Licensor its required license fees (the “Term”). The last day of the Term is called the Expiry Date. Shortly before 
the Expiry Date, the Licensor will send the User an invoice for renewal fees (which may be increased but not more 
than once each year) for use of the Licensed Software (subject to any changes that may be required with respect 
to EISI’s continuing right to sublicense the Third Party Software) during the proposed renewal period. The User 
will have 30 days within which to pay the invoiced amount. Upon payment being made, the Term will be extended 
for the renewal period. If the User does not make payment, the User’s license to use the Licensed Software will 
expire on the Expiry Date and all of the User’s rights to use the Licensed Software shall come to an end. Upon 
termination of this License Agreement as a result of breach of any of its terms and conditions by the User or 
expiry of the Term, the User shall make no further use of the Licensed Software, shall purge same from any 
computer into which it has been installed and shall destroy any copies thereof in his or her possession. In that 
event, the Licensor shall be entitled, but not obliged, to delete all information related to the User that has been 
provided to it, including data and financial plans pertaining to the User’s customers, to bar the User from having 
access to the Licensor’s Web Site and to any Licensed Software in the control of the Licensor. 

8.    Neither EISI, nor any Licensor other than EISI nor any Third Party Provider represents or warrants that the 
Licensed Software will meet the User’s requirements, that operation of the Licensed Software will be 
uninterrupted or error-free, or that all errors in the Licensed Software will be corrected.

9.   EISI is not in the business of providing advice with respect to the preparation of financial plans. The liability of EISI 
under this license agreement is limited to the correction of any error or malfunction in the licensed software and 
shall not include liability for loss of data, loss of computer time, any direct or indirect damages or any 
consequential, incidental, exemplary, punitive or special damages sustained by the User of the licensed software 
or by any third party who advances a claim against either EISI or the User, however caused and based on any 
theory of liability arising out of or relating to this license or the use of the licensed software, and regardless of 
whether EISI was advised of the possibility of such damages prior to or after this license came into effect. EISI 
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disclaims all other warranties and conditions, either express or implied, including but not limited to implied 
warranties and conditions of merchantability and (or) fitness for a particular purpose, whether statutory or 
otherwise, which are specifically excluded. The User of the licensed software acknowledges that the limitations set 
forth in this section are integral to the granting of this license and that, but for these limitations, fees payable by 
the User would have been subject to further negotiation and there is substantial likelihood that this license would 
not have been granted.

10.  The User agrees that no third party provider (which includes the third party provider and its stockholders, 
directors, officers, employees, and agents), of third party software warrants the accuracy, completeness, 
timeliness, reliability, fitness for a particular purpose or merchantability of any information to which User has 
access through the licensed software. User also agrees that no third party provider warrants the materials, 
workmanship or performance of the third party software. All other warranties, express or implied (including 
implied warranties of merchantability, fitness for a particular purpose and against intellectual property 
infringement by a third party provider) are excluded. In no event shall any third party provider be liable for (I) any 
loss, cost or damage, whether caused in whole or in part by negligence or otherwise, suffered by the User as a 
result of any decision made or any action taken in reliance upon information to which the User had access through 
the licensed software, or (II) any trading losses, lost profits or any other consequential, special or incidental 
damages, whether or not reasonably foreseeable, and even if advised of the possibility of such damages. The 
User acknowledges that the third party software and any and all information accessible through such software is 
the sole and exclusive property of the third party provider, which retains any and all intellectual property rights 
therein. The User agrees not to redistribute such information to any third party without written consent of the 
proper owner thereof. The User acknowledges that the third party providers are third party beneficiaries of, and 
are relying upon, the foregoing provisions.

  11. Each of the third party providers makes no warranties, guarantees, or representations of any kind, express or 
implied, with respect to the operation, capacity, speed, functionality, qualifications, or capabilities of the third 
party software provided by that third party provider that is integrated into the licensed software or any services, 
goods, personnel or resources provided hereunder, including without limitation, any implied warranty of 
merchantability or fitness for a particular purpose.  Each of the third party providers makes no representation, 
warranty or covenant concerning the accuracy, completeness, sequence, timeliness or availability of the third 
party software provided by such third party provider or the information accessed thereby or the likelihood of 
profitable trading using the said third party software or such information. As between each third party provider 
and the User, the User accepts full responsibility for any investment decisions or stock transactions made by its 
customers using such third party software or such information. No sales personnel, employees, agents or 
representatives of any third party provider are authorized to make any representation, warranty or covenant on 
behalf of such third party provider. No third party provider nor any of its affiliates represents or warrants that its 
third party software will be uninterrupted or error-free. The User expressly agrees that use of each third party 
software and the information is at its sole risk and that no third party provider shall be responsible for any 
termination, interruption of services, delays or errors caused by any transmission or delivery of the third party 
software and/or information or caused by any communications service providers.

12.  The User agrees that all communications between EISI, or any Licensor other than EISI, and the User, including 
information respecting enhancements and updates to the Licensed Software, may be by way of e-mail to the e-
mail address provided by the User.
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13.  If the version of the Licensed Software that is being licensed is based on tax principles of the United States:

(a)  The Licensed Software shall not be installed or used in any country that would violate the rules and 
regulations of the United States Department of Commerce, Bureau of Export Administration.

(b)  The Licensed Software is a “commercial item”, as defined at 48 C.F.R. 2.101 (October 1995) comprised of 
“commercial computer software” and “commercial computer software documentation” in accordance with 48 
C.F.R. 12.212 (September 1995). Pursuant to 48 C.F.R. 12.212 and 48 C.F.R. 227-7202-1 to and including 
227-7202-4 ((June 1995), all U.S. Government End Users acquire the Licensed Software with only the rights 
that are set forth herein. Emerging Information Systems Inc., 500-330 St. Mary Avenue, Winnipeg MB Canada 
R3C 3Z5.

14.  If you have been licensed to use the Licensed Software by a duly authorized licensee or sublicensee of EISI, then 
in consideration of EISI’s having consented to your being licensed as such, EISI shall be entitled to enforce this 
License Agreement as if it had directly licensed the Licensed Software to you on the terms and conditions of this 
License Agreement.

15.  This License is governed by the laws of the Province of Manitoba and the laws of the Canada in force therein (with 
the exception of choice of law principles) and the Court of Queen’s Bench of the said Province shall have exclusive 
original jurisdiction over any dispute respecting this License Agreement. If any part of this License is found to be 
unlawful, void or unenforceable, then that provision shall be deemed severed from this License and will not affect 
the validity and enforceability of any of the remaining provisions.
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Using this guide
Chapter 1:  Using this guide
The Basic Features Guide teaches new users how to use NaviPlan 
Standard. It explains how to start using the program and perform 
basic tasks. This section provides information to help you use this 
guide effectively.

Conventions used in the Basic Features Guide
The Basic Features Guide uses the following conventions:
•  The names of items that are labeled on the screen are capitalized 

and italicized. For example,
The Plan Settings dialog box opens.

•  Within instructions, the names of items that you must select, click, 
or enter appear in bold. For example,

 Click OK, and then enter Base Plan.
•  Multiple menu command instructions are listed together, separated 

by en dashes. For example,
Go to the Data menu, and then select Client – Add Family 
Member.

•  Keyboard references appear in uppercase with keys separated by 
plus signs if they are to be pressed together. For example,

CTRL+ALT+DELETE
•  Special terms, keywords, and cautions appear in italics for emphasis.

Finding more information
If you have a question that is not answered in this guide, there are 
other places to look for additional help: 

NaviPlan Standard Advanced Features Guide
The Advanced Features Guide provides more detailed instructions for 
using some of the basic features of NaviPlan Standard as well as 
instructions for using the more complicated features.
You can find a copy of the Advanced Features Guide on your installation 
CD, or on the NaviPlan Web site (www.naviplan.com).
Conventions used in the Basic Features Guide 1
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www.naviplan.com
Visit our Web site to access the following resources:

Help
The fastest way to get information about any item within NaviPlan 
Standard is to use Help. There are four ways to access Help:
•  Go to the Help menu.
•  Right-click the desktop, and then select Help. This will not work if 

any dialog boxes are open.
•  Click the Help button in the top-right corner of any dialog box.
•  Press F1.

Hints
Demonstrations of how to use some aspects of NaviPlan Standard are 
included in the application. To view the demonstrations, follow 
these steps:
1. Click Hints in the bottom-right corner of the screen. The Hints 

dialog box opens. The demonstrations are organized by subject in 
several tabs.

2. Go to the appropriate tab, and then click the name of the 
demonstration you want to view.

Technical support
You can contact NaviPlan Technical Support for more help.
•  E-mail: support@naviplan.com
•  Telephone: (888) 692-3474 (Mon.–Fri. 7am–7pm Central Time)
•  Fax: (204) 975-3726

•  Online tutorials •  NaviPlan product news

•  Training information •  Technical support

•  NaviPlan tips •  NaviPlan Support 
Forums
2 Finding more information



Using this guide
Essential Windows skills
This guide assumes that you know how to do the following:
•  Use the mouse (click, double-click, right-click, and drag).
•  Move, resize, and close a window.
•  Navigate through a dialog box and use scroll bars.
•  Choose menu commands and select options from windows and 

submenus.
If you are unsure about any of these Windows essentials, please refer 
to the Microsoft Windows user documentation.
Essential Windows skills 3
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Navigating in NaviPlan Standard
Chapter 2:  Navigating in NaviPlan Standard 
This section describes how to use various elements of the NaviPlan 
Standard window. Many elements of the program are standard 
Windows elements, while others are unique to NaviPlan Standard 
and require some explanation.
The NaviPlan Standard window is visible at all times while the 
program is running. Whether you are creating reports or working 
with data, you will always see the familiar menus and desktop.

Figure 1: Sample client with various reports and graphs

What is the title bar?
The title bar (1) is the bar at the top of the window. It displays the 
program name and the name of the client, if one is open. The system 
menu (2) and the window control buttons (4, 5, 6) are also located on 
the title bar.

Using the system menu
The system menu (2) is located in the left corner of the title bar, and 
contains commands to arrange the NaviPlan Standard window. Use 

Do not run more than one copy 
of the program at the same 
time. It is possible to start two 
copies, but you may encounter 
memory problems and other 
inconsistencies if you do.

2 1 3 4 5 6

10

12 11

13

 
7  8

12

9

What is the title bar? 5
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these commands to restore, move, size, minimize, maximize, or close 
the NaviPlan Standard window.

Using the window control buttons
There are several common window control buttons that appear in the 
right corner of many NaviPlan Standard title bars. These are as 
follows:
Context-sensitive Help: (3) Use to find Help information related to 
the open window or dialog box.
Minimize: (4) Use to reduce the NaviPlan Standard window (or any 
window) to an icon.
Maximize: Use to enlarge the NaviPlan Standard window (or any 
window) to its maximum size.
Restore: (5) This button appears when a window has been maximized. 
Click it to run the NaviPlan Standard program window (or any 
window) at less than full size. The restore button is useful when you 
want to run NaviPlan Standard side-by-side with another application.
Close: (6) This button appears on all windows and dialog boxes.
There are additional window control buttons that appear when 
graphs and reports are generated. These are as follows:
Compare: (7) Use to compare reports or graphs from two different 
plans. Click this button to open the Select a Plan dialog box, and then 
choose the plans to compare.
File folder: (8) Use to view or change the plan information from 
which a report or graph was created.

Using the menu bar
The menu bar (9) is the bar at the top of the window under the title 
bar. It displays menu names. NaviPlan Standard commands are 
grouped within the menus. Click a menu name to open it, and then 
click a command to select it. If a command appears gray and 
unavailable, it cannot be used at this time.

Using the desktop
The desktop (10) is the area within the NaviPlan Standard window. 
Items are placed here while they are being used (for example, plan 
folders and reports). You can move objects and windows partially off 
the desktop for more available working space, but you can never 
move an object completely off the desktop.

See Figure 1, “What is the 
title bar?” on page 5 for 
the location of each 
numbered element.

Use the Cancel button 
instead of Close wherever it 
is available. This prevents 
you from accidentally 
closing plans and 
losing data.
6 Using the menu bar
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Using the status bar
The status bar (11) is the bar at the bottom of the window. It displays 
messages while NaviPlan Standard performs its various tasks. For 
example, status messages appear on this bar while reports are 
generating.

Using the file cabinet
The file cabinet (12) is where your clients’ data and plans are stored. 
The file cabinet icon appears whenever a client file is opened. Since 
only one client file can be open at a time, there is never more than one 
file cabinet on the desktop at any given time.

Opening a file cabinet
To view the contents of the file cabinet, use any of these methods:
•  Go to the Window menu, and then select the name of the client file. 

The file cabinet window opens.
•  Double-click the file cabinet icon. The file cabinet window opens.
•  Right-click the file cabinet icon, and then select Open. The file 

cabinet window opens.

Figure 2: Plans inside the file cabinet window

Retrieving a plan from the file cabinet
You can have more than one plan on the desktop at the same time. 
You can also store plans in the file cabinet for later use. To retrieve a 
plan from the file cabinet, use any of these methods:
•  Open the file cabinet window, and then drag the plan folder onto 

the desktop.
•  Open the file cabinet window, and then double-click the plan 

folder.
•  Open the file cabinet window, right-click the plan folder, and then 

select Open.
Using the status bar 7
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Storing a plan in the file cabinet
To store a plan in the file cabinet, use any one of these methods:
•  Drag a plan folder onto the file cabinet icon.
•  Select the plan. Press CTRL+F4, and then click Yes in the 

confirmation box.
•  If the file cabinet window is open, drag the plan folder onto the 

open window.

Using the trash
The trash (13) is a temporary storage area for unwanted items in 
NaviPlan Standard. It is represented by the trash can icon. Items that 
can be placed in the trash are reports, graphs, concepts, and plans. 
These items remain in the trash temporarily in case you need to 
restore them to the desktop.
Trashed items are removed automatically if you do any of the 
following:
•  Add more items to the trash than it can hold (default is five items).
•  Close the current client file.
•  Open a new client file (when a client file is already open on the 

desktop).
•  Exit NaviPlan Standard.
•  Empty the trash.
For more information, see “Changing the capacity of the trash” on 
page 10 and “Emptying the trash” on page 10.

Opening the trash
To open the trash, use any of these methods:
•  Double-click the Trash icon.
•  Go to the Window menu, and then select Trash.
•  Right-click the Trash icon, and then select Open.

Trash is empty

Trash contains 
deleted items
8 Using the trash
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Figure 3: Discarded items in the trash

Placing an item in the trash
To remove an item from the desktop and place it in the trash, use any 
of these methods:
•  Minimize the item to an icon, and then drag it onto the Trash icon.
•  If the item is a window, press and hold down the CTRL key as you 

click the item's title bar. Drag the window onto the Trash icon, or 
right-click its title bar and then select Delete.

•  Select the item, and then press CTRL+DEL. (This keyboard shortcut 
works on all items except the file cabinet and the printer.)

•  If the item is a document, right-click its icon, and then select Delete.
•  Go to the Edit menu, and then select Delete.

Retrieving an item from the trash
To retrieve an item from the trash, use any of these methods:
•  Open the Trash window, and then drag the item onto the desktop.
•  Open the Trash window, and then double-click the item you want 

to retrieve. It appears in a window on the desktop.
•  Open the Trash window, right-click the item you want to retrieve, 

and then select Open.
•  If the item was just deleted, go to the Edit menu, and then select 

Undo Delete (or press CTRL+Z). The item is restored to its 
previous position on the desktop.
Using the trash 9
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Changing the capacity of the trash
The default number of items held in the trash is five. If you add a sixth 
item to the trash, the oldest item is discarded automatically.
To change the default number of items that can be held in the trash, 
follow these steps:
1. Go to the Edit menu, and then select Preferences. The Preferences 

dialog box opens.
2. Go to the System tab.
3. Under Desktop, change the number in the Maximum Number of 

Objects in the Trash field, and then click OK. The Preferences dialog 
box closes and your change is saved.

Emptying the trash
To permanently delete items in the trash, use either of these methods:
•  Go to the Edit menu, and then select Empty Trash.
•  Right-click the Trash icon, and then select Empty.
Closing the client file or exiting NaviPlan Standard automatically 
empties the trash.

Moving around in dialog boxes
To move around in a dialog box, use any of the following methods:
•  Press the TAB key to move from field to field.
•  Click the Next button at the bottom left of the dialog box to move to 

the next tab.
•  Click the Back button at the bottom left of the dialog box to move 

back to the previous tab.

Each trash item uses memory to 
maintain. Fewer items in the 
trash means more available 
memory for your application.
10 Using the trash
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Chapter 3:  Creating client files and plans
Using NaviPlan Standard, you will create a client file to store the 
personal and financial data of each client family member along with 
the clients’ financial plans. After you create the client file, you can 
begin to create plans for the client. A plan is a collection of financial 
data that relates to a specific client for a specific year.

Collecting client information
Before creating a new client file or plan, collect all of your clients’ 
relevant financial documents, such as the following:
•  Current tax returns and assessments
•  Pension statements from employers
•  Benefits statements from employers
•  Copies of any business buy/sell or shareholder agreements
•  Current pay stubs
•  Life insurance, disability insurance, and long-term care insurance 

policies
•  Most recent investment statements from banks, trust companies, 

brokers, and investment companies
•  Budget of personal and living expenses
•  Most recent mortgage and loan statements
•  Most recent will and power of attorney
•  Marital agreement(s)
•  Severance pay documents
•  Any other relevant documents
You can use NaviPlan Standard’s Fact Finder, a client information 
questionnaire, to collect client information. To open the Fact Finder 
document, go to the Concepts menu, and then select Fact Finder. You 
can customize the Fact Finder document by exporting it to a word 
processing application, and then editing it as required.

Setting defaults
Before starting to work with NaviPlan Standard, consider setting 
defaults in the Preferences dialog box. These defaults provide a starting 
point for entering basic client information.
Collecting client information 11
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To open the Preferences dialog box, use either of these methods:
•  Go to the Edit menu, and then select Preferences.
•  Right-click anywhere on the desktop, and then select Preferences.

Figure 4: Preferences dialog box

The defaults you enter into the Preferences dialog box are available for 
all clients and new plans, but they do not usually affect previously 
existing plans. As you enter information for an individual plan, you 
only have to change the values that are relevant for that 
particular plan.

Creating a client file
There are several steps involved in creating a client file for the first 
time: naming the client, defining the number of family members, 
specifying their state of residence, and entering each family member's 
birth date. Once the client file is saved, it stores the personal and 
financial data of each family member, along with the clients’ 
financial plans. 
To create a new client file, follow these steps:
1. Go to the File menu, and then select New Client. The New Client 

dialog box opens, and the Base Family tab is displayed.
12 Creating a client file
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Figure 5: New Client dialog box

2. On the Base Family tab, enter the clients’ general information. 
To enter more detailed information, such as the clients’ 
occupations and e-mail addresses, click the magnifying glass 
beside the client or co-client Given Name fields. The <client 
surname(s)> dialog box opens. Enter additional information, and 
then click OK. The dialog box closes.

3. Go to the Dependents tab. Enter the given names, genders, and 
birth dates of the clients’ family members, and indicate who claims 
the family member as a dependent.

4. Go to the Advisors tab. Enter the names of the clients’ lawyer, 
accountant, other financial advisors, and power of attorney. 
Indicate whether or not the clients have a will. (This information is 
optional.)

5. Go to the Planner Data tab. Enter information about the financial 
planner. 

6. Go to the Estate Beneficiaries tab. Any dependents named on the 
Dependents tab are carried over automatically to this tab. Apply 
any gifts that relate to the dependent(s). Insert any additional 
client beneficiary information required, and then click OK. The 
Save Client As dialog box opens.

Plan calculations are based on 
demographic information such as 
age and state. Therefore, it is 
crucial that this data is entered 
accurately.

The program prompts you to save 
only after you create a new client 
file. Once the client file is created 
and saved, all changes to the 
clients’ file are then saved when 
you click OK to exit the data entry 
screen.
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7. NaviPlan Standard suggests a file name in the Save Client As 
dialog box. Click OK to accept the file name and save the file, or 
enter a different name, and then click OK. A file cabinet appears 
on the desktop.

Editing client information
After the client file has been created, you may need to update the 
client information, for example, address information may change or 
you may need to add a new family member if your client gets married 
or has a child.
To edit client information, follow these steps:
1. Go to the Data menu and then select Client. A menu displays the 

following options:
•  Edit Data—edit the financial planner information
•  Edit Family Members—edit client or other family member’s 

information
•  Professional Advisors—edit the professional advisor information
•  Edit Beneficiaries—add or remove beneficiaries
•  Add Family Member—add new family member
•  Remove Family Member—delete a family member
2. Select the appropriate option. A dialog box opens.
3. Enter your changes and then click OK. The dialog box closes and 

your changes are saved.

Changing tax filing status
You can change the clients’ tax filing status from single to married but 
you cannot change from married to single without deleting all plans.
To change tax filing status from single to married, follow these steps:
1. Go to the Data menu and then select Client – Edit Family 

Members.
2. Go to the <client> or <co-client> tab.
3. Change the tax filing status from Single or Head of Household to 

Married Filing Jointly or Married Filing Separately. The other client’s 
tab is updated automatically.

4. Click OK. An alert message warns you that you cannot revert back 
to a single tax filing status without deleting all plans.

5. Click Yes on the alert message. The Edit Family Members dialog 
box closes.

If you would like to keep a copy of 
the original client file before adding 
or removing a family member, enter 
a different file name for the file in 
Save As and then click OK.

If you’re adding a new co-client, you 
must add that family member 
before you can change the tax 
filing status.

If you’re adding a new co-client, you 
must add that family member 
before you can change the tax 
filing status.
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Creating a base plan
A base plan is the first plan you create for your clients. This plan 
includes all of your clients’ current financial information. Do not 
analyze or make changes to the base plan. Instead, duplicate the base 
plan (see “Duplicating a plan” on page 26) and make changes to the 
copy. This allows you to analyze the clients’ financial plan and 
suggest ways to improve it without modifying the original plan.
To create a base plan that contains your clients’ existing financial 
information, follow these steps:
1. If you have just created a new client, the New Client Options dialog 

box may be on the screen. If so, the Create a New Plan option is 
selected by default. Click OK. The Create a New Plan dialog 
box opens.
If you have opened a client file and no dialog boxes appear on the 
screen, go to the File menu, and then select New Plan.

Figure 6: Create a New Plan dialog box

2. Enter a name for the plan.
3. Enter the current year.
4. Enter a description that includes any relevant information about 

your clients. (This is optional.)
Text entered here serves as notes for you when working on the 
plan; it does not appear in any reports or graphs.

5. Select Base Plan, and then click OK. Since this plan represents the 
clients’ current financial picture, you must select the Base Plan 
option to prevent NaviPlan Standard from calculating or 

Once you leave the General tab, you 
will no longer be able to change the 
year of the plan.
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recommending any required savings for your goals. (Once you 
have finished entering the base plan, you will begin planning for 
your client using a duplicate of the base plan.)
The Plan Settings dialog box opens.

Figure 7: Plan Settings dialog box

6. Enter the plan assumptions (see “Entering plan assumptions” on 
page 17).

7. Enter the clients’ financial information (see “Entering financial 
information” on page 20).

8. Click OK. The Plan Setting dialog box closes and all the 
information you entered is saved.

Changes are not saved until you 
click OK. If you selected the Manual 
save option in Preferences, changes 
are only saved when you go to the 
File menu and click Save.
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Entering plan assumptions
When you create a plan, before entering your clients’ financial 
information you should enter the assumptions on which the plan will 
be based. You can enter these assumptions in the Assumptions 
category, where you can accept or override many of the defaults set in 
the Preferences dialog box (see “Setting defaults” on page 11).

Opening the Plan Settings dialog box
The Plan Settings dialog box is the main data entry dialog box in 
NaviPlan Standard. To open the Plan Settings dialog box, use one of 
these methods:
•  Go to the Data menu, and then select an option (do not select Project 

Plan to next year, Implement Plan, Update Plan, or Import into Plan).
•  Double-click the plan folder icon.
The Plan Settings dialog box has category buttons on the left side 
labeled Assumptions, Incomes, Expenses, Assets, Loans, Strategies, Goals, 
Insurance & Estate Planning, and Planning Assistant.
Within each category there are multiple tabs (for example, the 
Assumptions category has the General, Tax Options, Risk Profile, 
Milestones, Historical Data, Tax, Asset Classes, Return Rates, and 
Inflation tabs).

Entering information in the Assumptions category
The Assumptions category contains several tabs. Click the tabs or the 
Next button to go to each tab in turn, and then enter your plan 
assumptions. The assumptions you enter in this category only apply 
to the active plan. Sometimes these assumptions override the 
information you entered in the Preferences dialog box (see “Setting 
defaults” on page 11).
The tabs are as follows:

General
On the General tab you can edit or rename the current plan. You 
can also enter comments to differentiate between plans and avoid 
possible confusion when it comes time to implement a 
specific plan.
The base plan is generally the first plan for a given client and 
represents the clients’ current financial situation. Use the Base Plan 
option to record any financial planning strategies the clients 
already have in place. 
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Tax Options
On the Tax Options tab you can choose how the tax calculations 
outlined in the Economic Growth and Tax Relief Reconciliation Act of 
2001 are applied in the plan.

Risk Profile
On the Risk Profile tab you can select the model portfolio that best 
suits your clients’ risk tolerance. This model portfolio is used in 
the plan and in documents to demonstrate a recommended asset 
mix to your clients. It is referred to as the Suggested Asset Mix.
You must enter model portfolios in the Preferences dialog box (see 
“Setting defaults” on page 11), or on the Assumptions category – 
Asset Classes tab – Portfolios subtab before you can select a model 
portfolio on the Risk Profile tab.

Milestones
On the Milestones tab you can edit the plan’s default settings. These 
settings are inherited each time a new plan for the family is 
created. Manipulating the data in this dialog box allows you to 
demonstrate the consequences on the family’s financial future of 
an early (or late) retirement date, or an untimely death.

Historical Data
On the Historical Data tab you can enter capital loss carryover 
amounts, as well as any cash flow surplus or deficit.

Tax
On the Tax tab you can define income tax rates for the three 
planning periods: pre-retirement, retirement, and estate. Within 
each of these life stages, you can also enter the estimated income 
range, and the tax rates based on that income (average, marginal, 
short-term and long-term capital gains). If necessary, you can 
override any of the tax rates shown by entering another 
percentage.

Asset Classes
In NaviPlan Standard there are two ways to calculate asset return 
rates: using asset classes (investment groups such as cash, fixed 
income, foreign equity, etc.) and using asset types (kinds of assets 
such as cash account, bond, mutual fund, etc.). Regardless of 
which calculation method you’re using, if you want to use the 
asset allocation features of NaviPlan (suggested asset mixes, 
reports, etc.), you must enter asset classes and model portfolios. 
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You must choose which method of calculating return rates you 
want to use. If you want to use the asset type method, go to the 
Return Rates tab. If you choose the asset class method, on the Asset 
Classes tab – Classes subtab, either in Preferences for all clients and 
plans or in Assumptions for an individual plan, select the Use Asset 
Class Weightings for setting asset return rates check box and 
enter asset classes and their return rates. You then have to enter 
asset class weightings for the individual assets in the plan (on the 
Assets category – Asset Class Weightings tab). If you enter asset 
classes and return rates in both Preferences and Assumptions—the 
entries in the Assumptions category (for the individual plan) will 
override the entries in the Preferences category (general defaults). 
On the Portfolios subtab, you can add, delete, or update model 
portfolios and their asset class weightings (either in Preferences for 
all clients and plans or in Assumptions for an individual plan). You 
only have to enter model portfolios if you want to use the other 
asset allocation features of NaviPlan.
On the Correlations subtab, you can set up or edit correlations between
asset classes specifically for the plan you have open. Setting up 
correlations results in more realistic outcomes. To set up default 
correlations for all future plans for all clients, go to the Edit menu, 
select Preferences, and then enter the correlations on the Asset 
Classes tab – Correlations subtab.

Return Rates
In NaviPlan Standard there are two ways to calculate asset return 
rates: using asset classes and using asset types. If you want to 
calculate asset return rates using asset types, go to the Return 
Rates tab, either in Preferences for all clients and plans or in 
Assumptions for an individual plan, and then select Use default 
return rates based on asset type for setting asset return rates. On 
the Return Rates tab, you can define the investment objectives and 
asset return rates that will be used during the clients’ pre-
retirement and retirement years. These objectives and return rates 
are used only if you are using the asset type method of calculating 
return rates.
If you want to use the asset allocation features of NaviPlan 
(suggested asset mixes, reports, etc.) you must also enter asset 
classes and model portfolios on the Asset Classes tab.
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Inflation
On the Inflation tab you can view the projected inflation rate. You 
can either leave this rate as is, or enter a different rate. Use the 
graph as a basis to help you determine what inflation rate might 
work best in the current situation.
The inflation rate you select is used as a default throughout the 
plan, but can be modified to suit different circumstances in various 
places within the plan.

Entering financial information
Once you have created a plan and entered the plan assumptions, you 
can enter your clients’ financial information into that plan. Enter the 
financial information in the Plan Settings dialog box.
Go to each category and tab in turn (except the Assumptions and 
Planning Assistant categories), and enter information about the clients’ 
existing financial situation. You can close the Plan Settings dialog box 
by clicking OK.
The information that follows describes some of the features available 
within each category in the Plan Settings dialog box.

Incomes
In the Incomes category you can enter regular or lump-sum incomes 
(for example, employment salaries, self-employment earnings, and 
alimony). You can also establish the guidelines for calculating 
retirement benefits such as defined benefit pensions and Social 
Security. In the Social Security subtab, you can choose to have 
NaviPlan calculate benefits, or you can manually enter the actual 
benefit amounts.  
You can edit an existing income by double-clicking the income entry, 
or selecting the entry, and then clicking Edit.

Expenses
In the Expenses category you can add or update pre-retirement 
lifestyle and employment expenses.
You can edit an existing expense by double-clicking the expense entry 
or by selecting the entry, and then clicking Edit.

Do not enter liabilities in the 
Expenses category. Enter them in 
the Loans category.

Don’t enter premiums for insurance 
policies entered in the Insurance & 
Estate Planning category. NaviPlan 
automatically deducts these 
premiums from cash flow.
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Assets
In the Assets category you can enter and edit your clients’ assets. This 
category is divided into the following tabs: Qualified, Non-Qualified, 
Lifestyle, and Asset Class Weightings.
Qualified plans in NaviPlan are those that are tax advantaged. In 
general, almost all of these plans have tax deferred growth and tax 
deductibility. Non-qualified plans have less government monitoring 
and are not tax advantaged. In NaviPlan, an UTMA/UGMA account is 
considered a non-qualified asset but a 529 plan is considered a 
qualified asset. Both of these assets can help fund future education 
costs. Lifestyle assets are personal property assets such as your 
residence, cottage, cars, etc.
You can insert an asset by going to the appropriate tab, and then 
clicking Insert. Select the appropriate asset type: Bond Portfolio, Cash 
Account, Mutual Fund, etc. If you want to enter an asset type that is not 
listed, select Investment Portfolio. A dialog box opens for the asset type 
so that you can enter additional information, such as the owner and 
purchase date. You can override the return rates in this dialog box, if 
necessary.
If you entered asset classes in the Preferences or Assumptions categories, 
you can edit an existing asset by double-clicking the asset entry. On 
the Asset Class Weightings tab you can enter the class weightings of 
each non-lifestyle asset.

Loans
In the Loans category you can work with all of the loan types that 
NaviPlan Standard supports: Interest-Only, Principal & Interest, and 
Last Period Payment. You can indicate whether a loan is insured for 
either life and/or disability. This information will be taken into 
account when insurance needs are calculated.
You can edit an existing loan by double-clicking the loan entry, or 
selecting the entry, and then clicking Edit.
You can view the full payment schedule of a loan by clicking View 
schedule in the Loans dialog box.

Strategies
In the Strategies category you can set up transactions to be 
automatically carried out at any time during the course of your 
clients’ lives. These strategies are divided into three tabs: Savings, 
Surplus Savings, and Debt Modification.

Premiums for insurance policies 
attached to loans should be entered 
in the Expenses category. Since the 
policies aren’t entered in Insurance 
& Estate Planning, NaviPlan can’t 
calculate the premiums.
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You can edit an existing strategy by double-clicking the strategy entry, 
or selecting the entry, and then clicking Edit.
In the base plan, enter only the strategies that the clients already have 
in place; do not enter new strategies (you can do that in duplicate 
plans).

Goals
In the Goals category you can enter the clients’ current retirement, 
education, and major purchase goals. Each goal can have a different 
investment objective or model portfolio.

Retirement
In plans other than the base plan, you can use this tab to calculate 
your clients’ annual after-tax income during retirement. You can 
calculate their annual income, retirement age, life expectancy, or 
desired estate. You can also link specific assets to the goal. You can 
view a summary of the assets you have linked to this goal by clicking 
Explain.
For example, if you want to know the savings required for your clients 
to have an annual after-tax retirement income of $150,000, follow 
these steps:
1. Select the Additional Savings option. 
2. Enter $150,000 in the Desired Annual Income field, and then 

press TAB.
NaviPlan Standard calculates the monthly non-qualified savings 
necessary for the clients to meet this goal, based on the value of linked 
assets and savings already defined within the plan.
If the clients wanted the same annual retirement income as in the 
previous example and wanted to retire at age 45, you would follow 
these steps:
1. Repeat steps 1 and 2 outlined above.
2. Press TAB until you reach the Retirement Age field for the correct 

client.
3. Enter 45 in the Retirement Age field, and then press TAB.

NaviPlan Standard recalculates the monthly non-qualified savings 
necessary for the clients to reach this new goal.

Education
On the Education tab you can enter the details of your clients’ future 
education goals. These goals can include tuition fees, room and board, 
and other expenses.

NaviPlan Standard does not 
calculate or recommend any savings 
to reach the goals until the base 
plan is duplicated and the planning 
phase begins.
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To enter a goal, click Insert. The Education Goal dialog box opens. Once 
you have entered an education goal, you can view a graph of average 
education costs to estimate future education costs. You can view the 
graph by using the View Average Education Costs feature at the bottom 
of the dialog box.
NaviPlan Standard can calculate the education costs that clients can 
afford based on their existing assets and savings strategies. In 
duplicated plans (non-base plans), NaviPlan Standard can calculate 
the additional savings required to fund the clients’ education goals. In 
base plans, the Don’t Calculate option can be used to prevent NaviPlan 
Standard from calculating anything at all. 
You can edit an existing education goal by double-clicking the goal 
entry, or selecting the entry, and then clicking Edit.

Major Purchase
On the Major Purchase tab you can set goals for one-time or lump-sum 
purchases such as a car, boat, cottage, or vacation.
After you have completed the base plan, duplicated it, and begun 
planning, select one of three calculation options to determine how this 
goal will be reached. If you select Purchase Date, NaviPlan Standard 
automatically calculates the date that this major purchase can be 
made based on the clients’ current savings plans and assets and the 
information entered in the Purchase Amount field. If you select 
Purchase Amount, NaviPlan Standard calculates the maximum 
purchase that the clients can afford, based on the clients’ existing 
assets and savings plans. If you select Additional Savings, NaviPlan 
Standard calculates what additional savings, if any, are required given 
the values entered in the Purchase Amount and Purchase Date fields.
You can edit an existing major purchase goal by double-clicking the 
goal entry or by selecting the entry, and then clicking Edit.

Insurance & Estate Planning
In the Insurance & Estate Planning category you can incorporate your 
clients’ life, disability, and long-term care insurance policies into the 
plan. Also, you can create or edit estate planning strategies, including 
many types of trust arrangements. Once all the data is entered, you 
can demonstrate the effects of adequate or inadequate estate planning 
and how it affects the future value of the clients’ estate.
See “Estate planning” on page 29 for detailed information on setting 
up an estate plan.
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Life Insurance
On this tab you can enter/edit your clients’ life insurance needs 
and policies. Life insurance coverage is calculated using one of 
two methods: goal and expense coverage, or income coverage. You 
can also edit the default return rates that will be applied to 
investing proceeds received from a life insurance policy. This can 
highlight any shortfalls that may prevent the surviving family 
members from maintaining their current lifestyle in the event of 
the premature death of one or both of the family heads.
In the base plan, enter only the clients’ existing life insurance 
policies. You can enter new strategies in duplicate plans.

Disability Insurance
On this tab you can enter/edit your clients’ disability insurance 
needs and coverage. In the base plan, enter only the clients’ 
existing disability insurance policies. You can enter new strategies 
in duplicate plans.

Long Term Care
On this tab you can enter/edit your clients’ long-term care 
insurance needs and policies. In the base plan, enter only the 
clients’ existing long-term care insurance policies. You can enter 
new strategies in duplicate plans.

Estate Planning Setup
On this tab you can enter/edit the details of any estate planning 
strategies that the clients already have in place.

Estate Planner
On this tab you can enter/edit multiple estate planning scenarios.  
Compare the new scenarios and choose the most favorable.
You can also access many estate planning reports from this tab, in 
addition to accessing them from the Reports menu.

Planning Assistant
The Planning Assistant category displays a quick analysis of plan 
results.
The Overview tab identifies problems, questions, opportunities, and 
observations, and alerts you to areas where changes could be made in 
the plan. You can review IRA contributions and unused contribution 
room on the Reports tab.
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NaviPlan Standard recommends additional savings to meet the 
specified goals on the Reports tab. The Cash Flow report on the Reports 
tab details annual surpluses and deficits from the current year until 
retirement. It will help you to decide if your clients can afford the 
recommended savings. This analysis is a quick and convenient means 
of monitoring the effects of different strategies on cash flow.
Any system-recommended savings strategies appear in bold italics on 
the Opportunities tab.

Using plans
Once a plan has been created, you can activate, delete, or duplicate the 
plan. You can also project the plan into the future.

Activating a plan
Each plan is contained within a distinctly colored file folder. The plan 
folder icon can appear in two states: open and closed.
Open: When the plan folder icon is open, the plan is active. Any 
changes made to the clients’ financial data will apply to this plan only. 
Only one plan can be active at any given time.
Closed: When the plan folder icon is closed, the plan is inactive. Data 
changes cannot be made to an inactive plan.
Use any of the following methods to activate a plan:
•  Click the plan folder icon.
•  Right-click the plan folder icon, and then select Edit.
•  Select a document of the same color on the desktop.
•  Press CTRL+F6 until the icon changes to the open position.
•  Go to the Window menu, and then select the plan’s name.
Plans can also be activated under the following circumstances:
•  When a document is pasted from the clipboard. If a document 

created from one of the clients’ plans is copied onto the clipboard 
and then later pasted onto the NaviPlan Standard desktop, the plan 
from which the document was created becomes the active plan.

•  When a plan is closed or placed in the trash. The last plan that was 
active becomes the active plan.

You can have several plans on the desktop, but only one can be active 
at a time. For example, if plan A is active, and you want to run a 
report for plan B, you must first select plan folder B to activate it.
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Duplicating a plan
Use either of these methods to duplicate a plan:
•  Right-click the plan folder icon, and then select Duplicate.
•  Go to the Edit menu, and then select Duplicate.

Deleting a plan
To delete a plan, place the folder in the trash. Plans placed in the trash 
are deleted when you do any of the following:
•  Right-click the plan folder icon, and then select Delete.
•  Close the client file.
•  Open a new client file.
•  Exit NaviPlan Standard.
•  Empty the trash.
For more information, see “Using the trash” on page 8.

Projecting a plan into the future
You do not have to re-enter your plan data every year. You can project 
a plan into the future.
To project a plan, go to the Data menu, and then select Project Plan to 
next year. This command duplicates the current plan and updates its 
values for the next plan year. The projected plan automatically carries 
out all transactions such as buying and selling assets and reducing 
liabilities.

Ensure that the current plan is 
complete and up to date before 
projecting the plan. Some items 
that apply only to previous years 
cannot be changed in the 
projected plan.
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Chapter 4:  Analyzing plans
NaviPlan Standard enables you to create an unlimited number of 
alternate plans. Use the Insurance & Estate Planning and Planning 
Assistant categories to analyze the usefulness of these plans.
Use the various reports and graphs to do further analysis. See 
Chapter 6: Using Documents for more information about reports 
and graphs.

Analyzing goals
NaviPlan Standard analyzes each plan to determine if the clients will 
be able to meet their financial goals.
To view NaviPlan Standard’s analysis of a plan, go to the Data menu, 
and then select Planning Assistant. The Overview tab is displayed. It 
summarizes the information you will find on each of the other tabs. 
Go to each tab to view a more detailed analysis.

Figure 8: Plan analysis

Analyzing personal insurance needs
Disability, long-term care, and life insurance analyses allow you to 
examine the effect that an unexpected disability, the need for long-
term care, or death might have on the clients’ plan. These analyses 
provide a way to incorporate income variations, goal re-adjustments, 
Analyzing goals 27



NaviPlan Standard Basic Features Guide
and expense fluctuations into a clients’ insurance coverage, and 
identify any shortfalls in that coverage.
Similarly, a long-term care analysis lets you study the family’s needs, 
should a family member require long-term care.
Do not perform an insurance analysis until you are ready to 
recommend a plan to the clients. Since insurance needs change as the 
plan changes, an insurance analysis should only be performed once 
the plan is ready to be presented to the clients. Duplicate your plan 
before you perform an insurance analysis.
There are two ways to open the Plan Settings dialog box to the 
Insurance & Estate Planning category (if it is not already open). Use 
either one of the following methods:
•  Go to the Data menu, and then select Life Insurance, Disability 

Insurance, or Long Term Care Insurance.
•  Double-click the plan folder icon. Go to the Insurance & Estate 

Planning category, and then go to the insurance tab required.

Figure 9: Insurance & Estate Planning category – Life Insurance tab

For information on entering insurance policies, see “Insurance & 
Estate Planning” on page 23.
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Chapter 5:  Estate planning
Estate planning is the process of evaluating your clients’ assets, and 
planning for the dispensation of those assets after the clients’ deaths. 
NaviPlan Standard’s powerful estate planning feature enables you to 
produce accurate and reliable estate plans that are tailored to 
individual clients. NaviPlan Standard even allows you to view the 
effect of estate planning strategies on the clients’ existing 
financial plan.
For more information on estate planning, refer to the Help.

Entering estate planning assumptions
Follow these instructions to set estate planning assumptions that will 
apply to the estate plan scenarios you set up and to any existing estate 
planning strategies:
1. Select the plan to which you will apply the estate planning actions.

Figure 10: Estate Planning Setup tab – General subtab

2. Go to the Insurance & Estate Planning category – Estate Planning 
Setup tab. This tab allows you to record the clients’ existing estate 
planning information, as well as general information to be used in 
alternative scenarios.

3. On the General subtab, define the rates that will be used to 
calculate various additional fees.
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4. If you want to specify which client dies first, select the Specify by 
Order of Death option.

5. NaviPlan automatically calculates state taxes based on state tax 
tables. Go to the State Taxes subtab and review state death tax 
assumptions. To override the automatic NaviPlan calculations, 
select the Override check box.

6. If your clients are using some estate planning strategies, complete 
the procedure “Entering existing estate planning data” on page 30. 
Otherwise, skip to the procedure “Reviewing the existing estate 
plan” on page 32 to view a summary of the assumptions you’ve 
entered. 

Entering existing estate planning data
If your clients already have some funded trusts or lifetime gifts, 
follow these instructions to create a plan that includes them:
1. Select the plan to which you will apply the estate planning actions.
2. Complete the procedure “Entering estate planning assumptions” 

on page 29 if you haven’t already done so.
3. Go to the Historical Data subtab, and then define any historical 

estate tax information that applies to each family head.
4. Go to the Funded Trusts subtab, and then define any existing 

trusts the clients have. Do not enter any trusts that the clients have 
planned, but that are not yet funded. Click Insert, and choose the 
trust type. A dialog box opens so that you can enter the details of 
the trust. 

5. Click Remainder To and then enter the remainder beneficiaries of 
the trust and the corresponding percentages. For more 
information, see “Entering remainder or income beneficiaries of a 
funded trust” on page 31. 

6. To enter income beneficiaries other than the co-client, click Income 
To and then enter the income beneficiaries of the trust and the 
corresponding percentages. For more information, see “Entering 
remainder or income beneficiaries of a funded trust” on page 31.

7. Click OK to close the Trusts dialog box.
8. Go to the Gifting Growth & History subtab, and then enter 

growth information about the gifts to each beneficiary.
9. Dependents are automatically designated as beneficiaries when 

you create the client file. If you need to create additional 
beneficiaries (for example, charities, other heirs, etc.), go to the 

 If you select the Specify by 
Order of Death option and then 
change back to Mirror Wills/Either 
Dies First, you will lose any 
information you entered in the 
Estate <client or co-client> dies
first tabs.

Funded trusts are trusts that  
already have assets transferred 
into them.
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Data menu, and then select Client – Edit Beneficiaries. Click 
Insert, and then select the appropriate beneficiary type.

10. Go to the Estate Expenses subtab, and then define the expenses 
that will occur upon the death of either family head. You can also 
define expenses on a First to Die or Last to Die basis.

11. Review the existing estate plan as explained in “Reviewing the 
existing estate plan” on page 32.

Entering remainder or income beneficiaries of a 
funded trust
If the trust has remainder or income beneficiaries other than the 
co-client, follow these steps: 
1. Enter the applicable trust as explained in “Entering existing estate 

planning data” on page 30 (step 4).  
2. After you’ve entered the details of the trust in the applicable 

dialog box...
To enter remainder beneficiaries, click Remainder To. The 
Beneficiaries dialog box opens.
OR 
To enter income beneficiaries, click Income To. The Beneficiaries 
dialog box opens. 

Figure 11: Beneficiaries dialog box

3. Click Insert, and then select the name of the beneficiary who will 
inherit the remainder of the trust  if you’re entering remainder 
beneficiaries OR the name of the beneficiary who will inherit the 
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income of the trust if you’re entering income beneficiaries. Repeat 
this step until all beneficiaries have been entered.
OR
Click Add All to add all beneficiaries entered in the plan. 
If a beneficiary does not appear in the Insert list, click Create 
Beneficiaries. The Estate Beneficiaries dialog box opens. Click 
Insert, select Charity, Heir, or Other, and then enter a name for the 
new beneficiary. Click OK to close the Estate Beneficiaries dialog 
box. The new beneficiary now appears in the Insert list.

4. Enter the percentage of the trust applicable to each beneficiary.
OR
Click Pro-Rata to distribute the remaining amount equally among 
all beneficiaries.

5. Click OK to close the Beneficiaries dialog box and save your 
changes.

Reviewing the existing estate plan
1. Go to the Insurance & Estate Planning category – Estate Planner 

tab. The Current Scenario subtab is displayed. The chart displayed 
in Figure 12 shows asset distribution totals based on the active 
plan. If your clients are not using any estate planning strategies, 
this chart will represent a “sweetheart” or “I love you” trust where 
probate is due after the death of each client. The remaining 
amount is then designated as the final estate.

2. Each node in the flowchart displays various options when you 
click it. All nodes offer a report, while some offer access to further 
editing dialog boxes.
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Figure 12: Estate Planner tab – Current Scenario subtab

3. Click the Reports button below the chart, and then select 
Flowchart. This flowchart expands on asset distribution by 
showing the resulting costs (taxes and probate fees, etc.) for each 
client. The final estate amount is shown along with total taxes and 
net to heirs.

4. Close the Estate Planning Flowchart (Landscape) window 
when done.
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Implementing new estate planning strategies
You can duplicate the original estate planning scenario to create many 
different scenarios. A new scenario is not applied to the current plan 
until you click the Recommend button.
To create a scenario for a client, follow these instructions:
1.  Go to the Insurance & Estate Planning category – Estate 

Planner tab.
2. Go to the estate planning scenario subtab you wish to duplicate.
3. Click Duplicate. The Estate Planning Scenario Setup dialog 

box opens.

Figure 13: Estate Planning Scenario Setup dialog box

4. Enter a name for the scenario that will distinguish it from any 
other scenarios you create for the clients.

5. Enter a description of the scenario. (This is optional.)
6. Under Estate Planning Tools, select the options you wish to 

examine.
If you want to enter a trust or a family limited partnership, you 
must first select Will Exists. You cannot define a trust without a 
valid will in force. Selecting a will makes the trust-related estate 
planning tools available.

7. Click OK. The Estate Planning Scenario Setup dialog box closes and 
a subtab describing the new scenario appears on the Estate 
Planner tab.

Before implementing new estate 
planning strategies, you should 
create a plan that describes the 
clients’ current estate planning 
state. See “Entering estate 
planning assumptions” on 
page 29.
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8. Enter the applicable trusts, gifts, etc., as described in the following 
procedures.

Edit asset details
To edit asset details, follow these steps:
1. In the flowchart, click the Gifts and Bequests node (or the node 

that shows the clients’ total assets), and then select Edit Asset 
Estate Details. The Asset Estate Details dialog box opens listing all 
of the clients’ assets.

2. Review how each of the clients’ assets will be disposed of and 
make changes if required. 

Enter new gifts or bequests
To enter gifts or bequests, follow these steps:
1. Click the Gifts and Bequests node in the flowchart, and then 

select the type of gifting strategy you want to open. A Gifting 
Strategies or Bequest Strategies dialog box opens.

2. Click Insert, Insert Regular, or Insert Lump Sum. A Gifting dialog 
box opens.

3. Enter the details of the gift or bequest.
If the beneficiary of the gift is not in the Gifted To list, click Create 
Beneficiaries. The Estate Beneficiaries dialog box opens. Click 
Insert and then select Charity, Heir, or Other, and then enter a 
name for the new beneficiary. Click OK to close the Estate 
Beneficiaries dialog box. The beneficiary is now available in the 
Gifted To list. 

4. Click OK to close the dialog box.

Enter new credit shelter trust
To add a credit shelter trust, follow these steps:
1. Click the Credit Shelter Trust node in the flowchart, and then 

select Edit Credit Shelter Trust. The Credit Shelter Trust dialog box 
opens.

2. Enter the details of the trust.
If you want to specify the assets that will fund the trust, clear the 
Autofund check box. The Funding Assets tab displays. Click Insert 
and select the asset. The Transfer dialog box opens. Specify the 
amount or percentage to be transferred. Click OK to close the 
Transfer dialog box.
If the Autofund option is not cleared, NaviPlan automatically 
selects the assets to fund the trust.

To enter new gifts or bequests, the 
Gifting option in the Estate 
Planning Scenario Setup dialog 
box must be selected.

To add new credit shelter trusts, 
the Credit Shelter Trust option in 
the Estate Planning Scenario 
Setup dialog box must be selected.
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3. Enter remainder and income beneficiaries if applicable. See 
“Entering remainder or income beneficiaries of a new trust” on 
page 37 for more information.

4. Click OK to close the dialog box.

Entering a living trust
If you selected the Living Trust option in the Estate Planning Scenario 
Setup dialog box, NaviPlan Standard assumes that all assets in the 
plan are in the trust and therefore not subject to probate fees. You 
don’t have to do anything else.

Entering a new marital trust or QTIP
To add a marital trust or QTIP, follow these steps:
1. Click the node after the first death, and then select Edit Other 

Marital Trusts. The Trusts dialog box opens.
2. Click Create, and then select the type of trust you want to enter.
3. Enter the details of the trust. 

If you selected Asset Transfer as the funding method, go to the 
Transfers tab to specify the assets that will be transferred to the 
trust. Click Insert and select the asset. The Transfer dialog box 
opens. Specify the amount or percentage to be transferred. Click 
OK to close the Transfer dialog box.

4. Enter remainder beneficiaries if applicable. See “Entering 
remainder or income beneficiaries of a new trust” on page 37 for 
more information.

5. Click OK to close the dialog box.

Entering a new irrevocable trust
To add an irrevocable trust, follow these steps:
1. Click the Irrevocable Trusts node in the flowchart, and then select 

Edit Trusts. The Trusts dialog box opens.
2. Click New ILIT or Create.

If you selected New ILIT, the Irrevocable Life Insurance Trust (New 
Policy) dialog box opens. Skip to step 4.
If you selected Create, select the type of trust you want to enter. 
The Select Asset to Transfer to Trust dialog box opens.

3. Select an asset, and then click OK. The related Trust dialog 
box opens.

4. Enter the details of the trust.

To add marital trusts and QTIPS, 
the Other Marital Trusts option in 
the Estate Planning Scenario 
Setup dialog box must be selected. 

To add new irrevocable trusts, the 
Irrevocable Trusts option in the 
Estate Planning Scenario Setup 
dialog box must be selected.
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5. Enter remainder and income beneficiaries if applicable. See 
“Entering remainder or income beneficiaries of a new trust” on 
page 37 for more information.

6. Click OK to close the dialog box.

Entering a new testamentary trust
To add a testamentary trust, follow these steps:
1. Click the Testamentary Trusts node in the flowchart, and then 

select Edit Testamentary Trusts. The Trusts dialog box opens.
2. Click Create, and then select Generic Testamentary Trust. The 

Generic Testamentary Trust dialog box opens. 
3. Enter the details of the trust.
4. Enter remainder and income beneficiaries if applicable. See 

“Entering remainder or income beneficiaries of a new trust” on 
page 37 for more information.

5. Under Funding Amount, if you selected Maximize Exclusion or 
Value ($), go to the Funding Assets tab to specify the assets that 
will be transferred to the trust. Click Insert and select the asset. 
The Transfer dialog box opens. Specify the amount or percentage to 
be transferred. Click OK to close the Transfer dialog box.

6. Click OK to close the dialog box.

Entering remainder or income beneficiaries of a 
new trust
To enter remainder or income beneficiaries, follow these steps:
1. Enter the applicable trust as explained in “Implementing new 

estate planning strategies” on page 34.
2. To enter remainder beneficiaries,  click Remainder To in the trust 

dialog box. The Beneficiaries dialog box opens.
OR
To enter income beneficiaries, click Income To in the trust dialog 
box. The Beneficiaries dialog box opens. 

To add new testamentary trusts, 
the Testamentary Trusts option in 
the Estate Planning Scenario 
Setup dialog box must be selected.
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Figure 14: Beneficiaries dialog box

3. Click Insert, and then select the name of the beneficiary who will 
inherit the remainder/income of the trust. Repeat this step until all 
beneficiaries have been entered.
OR
Click Add All to add all beneficiaries entered in the plan.
If a beneficiary does not appear in the Insert list, click Create 
Beneficiaries. The Estate Beneficiaries dialog box opens. Click 
Insert, select Charity, Heir, or Other, and then enter a name for the 
new beneficiary. Click OK to close the Estate Beneficiaries dialog 
box. The new beneficiary now appears in the Insert list.

4. Enter the percentage of the trust applicable to each beneficiary.
OR
Click Pro-Rata to distribute the remaining amount equally among 
all beneficiaries.

5. Click OK to close the Beneficiaries dialog box and save your 
changes.
38 Implementing new estate planning strategies



Using documents
Chapter 6:  Using documents

Creating documents
You can use NaviPlan Standard to generate several different kinds of 
reports, graphs, and concepts. 

Creating reports
You can create reports in NaviPlan Standard from the following 
locations:
•  the Reports menu
•  Insurance & Estate Planning category – Estate Planner tab – Reports 

button
•  the Generate <name of report> icons on the desktop

Creating a report using the Reports menu
To create a report, follow these steps:
1. Make sure a client file is open on the desktop.
2. Go to the Reports menu, and then select an option. The specified 

report displays.
The page icon represents minimized reports created in this way. The 
color of the report icon matches the color of the plan folder from 
which it was created.

Figure 15: Sample report

To print reports, see “Printing documents” on page 45.
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Creating a report using a Generate <name of Report> icon
The Generate <name of report> icons on the NaviPlan Standard desktop 
allow you to generate detailed, full-color reports for your clients that 
show many of the findings in your proposed plan. 
To create a report, follow these steps:
1. Drag the desired plan folder onto the Generate <name of report> 

icon. The Select Base Plan for Document dialog box opens.
2. You have the option of letting NaviPlan Standard select a base 

plan for you, or you can manually choose a base plan. Once you 
have selected your base plan for the reports, click OK. The Select 
Document Sections dialog box opens.

3. Select the sections you want included in the report, and then click 
OK. The dialog box closes. The status bar displays update 
messages as each portion of the report is calculated, and then the 
report window appears on the screen.

The icon for a generated report differs slightly from a regular 
NaviPlan Standard report icon, but the color of the icon still matches 
the color of the plan folder from which it was created.

Creating an estate planning report from the Estate 
Planner tab
You can create estate planning reports from either the Reports menu or 
from the Insurance & Estate Planning category – Estate Planner tab.
To create estate planning reports from the Estate Planner tab, follow 
these steps:
1. Go to the Insurance & Estate Planning category – Estate 

Planner tab.
2. Click the Reports button.
3. Select (click) the report you want to create. The applicable 

report opens.

Creating graphs
Many types of graphs can be created with NaviPlan Standard. 
Regardless of the graph type chosen, the graph icon appears the same 
with the name of the graph under the icon for easy reference. The 
color of the graph icon matches the color of the plan folder from 
which it was created. 
NaviPlan Standard can create the following graph types:

•  Bar •  Stacked bar

In NaviPlan Standard, you 
cannot save reports 
unless they are exported 
or edited as text 
documents.
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When creating a pre-set graph using the Graphs menu, the type is 
selected automatically to best reflect the data. Once the graph is 
created, you can customize its display to suit your needs.

Changing a graph's viewing options
To change the appearance of a graph, use any of the following 
methods:
•  Right-click any of the graph’s data series to access options such as 

type, color, pattern, and polymarkers.
•  Right-click the graph’s legend to access display options such as size 

and position.
•  Right-click an axis label to display a menu of axis options.
•  Click anywhere in the area around a graph to display a menu of 

general graph options.

3-D graphs only
•  Use the horizontal scroll bar to change the rotation of the graph.
•  Use the vertical scroll bar to change the elevation of the graph.
•  Use the scroll bars on the sides and bottom of a 3-D graph to change 

the viewing angle. You can access the 2-D and 3-D viewing options 
by right-clicking anywhere in the area around the graph.

•  Use the vertical scroll bar to change the perspective of the graph 
(available only in 3-D perspective graphs).

•  Line •  Stacked line

•  Area •  Stacked area 
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Figure 16: 3-D rotated graph

Using concepts
Concepts are financial calculators that help to illustrate common 
financial planning concepts and ideas in the form of reports, graphs, 
or tables. You can use concepts to demonstrate various scenarios, such 
as the effects of inflation over time.
Concepts are represented by light bulb icons. The name of each 
concept appears under its icon.
Since concepts are not tied to any specific plan, they can be used as 
stand-alone calculators when there is no client file open. These 
concepts cannot be saved. However, if a concept is used when there is 
a client file open (a file cabinet icon is present on the desktop), the 
concept is saved in the file cabinet.
To generate a concept, go to the Concepts menu, and then select an 
option. Some options produce reports immediately. Other options 
require you to enter information that will define the concept before 
you can view the report.

Figure 17: Sample concept

Each concept you create is placed on the desktop. Minimize the 
concept. You can store concepts in the file cabinet with your clients’ 
plans, leave them on the desktop, or place them in the trash.
To print concepts, see “Printing documents” on page 45.

In NaviPlan Standard, you 
cannot save graphs unless 
they are exported or edited as 
text documents.
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Generating a presentation
You can use the overhead projector icon or the Reports menu to create 
and display a full-color presentation on your computer screen.

Figure 18: First page of a sample presentation

Viewing a presentation
To view a presentation, follow these steps:
1. Drag a plan folder onto the Generate Presentation icon.

OR
Go to the Reports menu, and then select Client Presentation. 
OR
Right-click a plan folder, and then select Client Presentation.
The Select Base Plan for Document dialog box opens. 

2. Select the base plan that you want to use to compare in the report. 
The presentation generates.

3. Once the presentation is running, you can use the toolbar, or the 
up, down, left, and right arrow keys to navigate through the pages, 
or right-click the presentation screen for a navigation menu.

Exiting a presentation
To exit a presentation, follow one of these procedures:
•  Press the ESC key while the presentation is running.
•  Right-click the presentation screen, and then select Done.
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•  Click the square button in the bottom-right corner of the 
presentation screen.

In either case, the presentation ends and the NaviPlan Standard 
desktop reappears.

Printing a presentation
You can print a presentation either in black and white or in color, 
depending on your printer’s capabilities.
To print a presentation on the default printer, right-click the screen 
while the presentation is running, and then select Print (or press 
CTRL+P). The presentation is sent to the default printer and is printed 
in landscape orientation.
If you want to set your printer options before printing, right-click the 
screen while the presentation is running, and then select Print 
Preview (or press CTRL+SHIFT+P). The Print Preview dialog box 
opens so you can set the options before printing.

Updating documents
All document windows have an update feature that ensures the 
document always displays the most current data. When a data change 
is made, any open window updates automatically. Documents also 
update automatically when they are printed.
Whenever an active plan's data is changed, any document in icon 
form will have a red X on top of it. This symbol indicates that the item 
is out of date. Any documents that are not in icon form automatically 
update on the screen (unless the Manual Update feature is selected). To 
update a document in icon form, double-click the icon to open it. The 
Auto Update feature updates the document.
By default, all document windows have the Update feature set to Auto. 
To change this default, right-click the document's title bar if the 
document is open, and then select Update – Manual. If the document 
is in icon form, right-click the icon and then select Update – Manual.
To manually update a document, follow either of these steps:
•  If the document is in icon form (with an X through it), double-click 

it. When the document window opens, its data updates 
automatically.

OR
•  If the document is in icon or window form, right-click its icon or 

title bar, and then select Update – Update Now.
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Printing documents
You can print any reports, graphs, and concepts created in NaviPlan 
Standard.

The Printer icon
For quick printing of single documents or client reports, drag the 
document icon onto the Printer icon. The Printer dialog box opens.
More than one printer icon can be on the desktop, but only one printer 
can be active at a time. This feature enables you to define multiple 
printers or even different settings for the same printer where each 
group of settings is represented by a separate icon. For example, one 
icon can represent a printer that is set to print items in color and 
landscape orientation, while another icon can represent a printer that 
is set to print items in black and white and portrait orientation.
The active printer icon displays a green light, while inactive printers 
do not. To activate a printer, click its icon.

Printing a document
To print a document, open the Printer dialog box, make any changes 
to the print settings, and then click Print. Documents can be printed 
immediately, or can be added to the printer queue and printed later.

Figure 19: Printer dialog box

The green light on the printer icon flashes as the document prints. 

 Do NOT use the  
button to close the Printer 
dialog box unless you want to 
remove that printer from 
NaviPlan.
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Opening the Printer dialog box
To open the Printer dialog box, use any one of the following methods:
•  Right-click a document, and then select Print.
•  Select a document, and then drag it onto the Printer icon or Printer 

dialog box. (If the Printer dialog box is already open, drag the item 
anywhere within it. The document is added to the bottom of 
the list.) 

•  Select the document, go to the File menu, and then select Print.
•  Select the document, and then press CTRL+P.
•  Right-click the item’s icon or title bar, and then select Print.

Printing immediately or queuing documents to print later
To print documents immediately, open the Printer dialog box, and 
then select Print Immediately. If this option is not selected, the 
documents are automatically added to a print queue.
Queuing documents places them in a print order and then prints them 
when you are ready. In order to queue documents for printing, follow 
these steps:
1. In the Printer dialog box, clear the Print immediately check box.
2. Drag each item onto the Printer dialog box in the order you want 

them to print.
3. Change any printer options or settings, and then click Print.

Printing multiple documents
1. Go to the File menu, and then select Print Multiple.

The Printer dialog box opens, and any printable items that are on 
the desktop (for example, reports) are displayed and selected. 

2. To print only some of the documents displayed, click the ones 
you want.

3. Select the settings, and then click Print to send the selected 
documents to the printer.

Adding and removing printers
To add a new printer to the desktop,
1. Go to File menu, and then select New Printer.
2. Assign printer settings.
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To remove a printer from the desktop, right-click the Printer icon, and 
then select Close.  Or, if the Printer dialog box is open, click the close 

 button on the title bar. The printer closes and is permanently 
removed from the desktop.
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Chapter 7:  Frequently asked questions

Questions about NaviPlan Standard

Why are some menu items gray and unavailable?
There are three possible reasons:
•  No client file is open on the desktop. To open a client file and 

enable the menu items, go to the File menu, and then select Open 
Client.

•  No plan is open on the desktop. To open a plan, right-click the file 
cabinet icon, and then click Open. Drag the desired plan onto the 
desktop or double-click its icon.

•  An applicable object is not selected on the desktop. Select an 
object and retry the command.

Why are some buttons gray and unavailable?
There are two possible reasons:
•  You have not created any assets in a strategy. Use the Insert button 

to create an asset for use with the strategy.
•  The function related to the button cannot be used for the current 

action.

Why do I have a file cabinet with no plans in it?
You may have recorded information on the client such as name and 
date of birth, but have not actually recorded assumptions or financial 
data for the client. See “Entering plan assumptions” on page 17  and 
“Entering financial information” on page 20 for instructions on 
creating a plan.

Why is there no printer icon on the desktop?
There are two possible reasons:
•  The printer icon has been closed. To open it, go to the File menu, 

and then select New Printer. A new Printer dialog box opens. When 
you have finished using the printer, minimize the Printer dialog 
box. If you click the close button in the top right corner of the dialog 
box, the printer icon closes again.

•  There is no valid printer defined on your computer. Contact your 
systems administrator.
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How do I return to data entry?
Use any of the following instructions:
•  Right-click the plan folder, and then select Edit.
•  Go to the Data menu, and then select Assumptions.
•  Click the file folder icon in the title bar of any report or graph to 

edit the information included in the associated plan.
•  If you want to go to a particular category to enter data, go to the 

Data menu, and then select that category.

Questions about plans

What happened to my asset class entries in 
Assumptions?
If you did not enter defaults in Preferences, and then used the Revert to 
Defaults option in the Assumptions category, your asset class values 
will be cleared. To prevent this from happening, go to the Edit menu, 
select Preferences, and then enter asset classes and other defaults that 
will apply to all clients and plans in NaviPlan Standard. You can 
override these defaults in any individual data entry screen that 
displays them. Refer to “Setting defaults” on page 11 for more 
information.

Questions about documents

How do I edit a document from within NaviPlan 
Standard?
This feature is only available if you have Microsoft Word installed on 
your computer. Either of the following procedures will convert the 
NaviPlan Standard menu commands to your Word menus and allow 
you to modify the text directly in NaviPlan Standard.
•  With the document selected, go to the File menu, and then select 

Edit <document name> As Text Document.
OR
•  Right-click the title bar of the document, and then select Edit – As 

Text Document.
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How do I copy a document to another Windows 
application?
1. Right-click the document icon, and then select Copy.
2. Start the word processing program where you want the copy to be 

placed, and then either select Edit – Paste or press CTRL+V.

Why won’t my documents print?
The printer is turned off or disconnected. Check that the printer is 
properly connected to your computer, check that it is plugged in, and 
then turn the printer on again.

Why does my document print incorrectly?
The printer driver is the wrong version. Contact the printer's 
manufacturer to get the latest version of the driver. Most printer 
drivers can be downloaded from the manufacturer’s Internet 
home site.

Why does my document only partially print?
There are several reasons why this may happen. To get around this 
problem, save the document in RTF format [see instructions below] 
and open it in a word processing program where you can print the 
document in sections. (You must export the report in order to print it 
in sections, as NaviPlan Standard will not do this.)
To save the document in RTF format, follow these steps:
1. Go to the File menu, and then select Export Documents.
2. Enter a name for the document.
3. Under File Type, select Formatted Text (*.rtf).
4. Select the drive and directory to which you want to save the 

document, and then click OK. 
This message appears:

Figure 20: Confirmation box prompting to open the RTF file

5. Click Yes to automatically open the document in your word 
processing application. Print it in smaller sections of one or two 
pages at a time.
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NaviPlan Standard - Extended conversion

Can I open NaviPlan Extended files in NaviPlan 
Standard?
No, but you can open NaviPlan Standard files in NaviPlan Extended.
When you open a NaviPlan Standard client file in NaviPlan Extended, 
you will need to enter additional information that was not required in 
NaviPlan Standard.
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Glossary
529 plan This is an investment plan that is considered a qualified asset. It 

allows your clients to save for future education costs. You can 
contribute up to the annual maximum amount allowed without any 
gift tax implications.

active plan folder An icon that indicates that a specific plan is currently in use. The plan 
is identified by a name directly below the folder, for example, New 
Plan or Proposed Plan. 
Since there can be a number of plans per family, each plan has a 
distinctly colored folder that holds the financial data for all family 
members for a specific period. For example, a plan in 2003 will have a 
different colored folder than the same plan that has been projected 
to 2004.

area graph A graph that illustrates how values change over a specific period. The 
purpose of the graph is to provide a picture of the effect certain 
planning features (for example, income taxes or the rate of inflation) 
would have over a given period.

asset class A category of assets with similiar characteristics, for example, fixed 
income and foreign equity.

asset class weightings A percentage breakdown of the various asset classes within specific 
portfolios (for example, 10% cash, 20% fixed income, etc.).

asset type Kind of asset or form of investment, for example, cash account, bond, 
or mutual fund.

bar graph A graph that shows the relationship of values for various items at a 
specific time. It can also illustrate changes over time with respect to a 
specific item.

base plan Generally the first plan you create for a client. It provides a picture of 
the clients’ current financial situation and includes any financial 
planning strategies in which the client may already be engaged. Base 
plans are denoted by a hand under the folder icon.

bypass trust See credit shelter trust.
C trust See qualified terminable interest property trust.
capital loss carryover Capital losses occur when certain assets are sold for less than their 

original value. If losses exceed the yearly limit on capital loss 
deductions, they can be carried forward to the next year and treated 
as if they occurred in that next year. To help reduce taxes, losses can 
be carried over to later years until completely used.
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client file Stores the personal and financial data of each family member along 
with the clients’ financial plans.

Clipboard A temporary storage area in computer memory that is used to hold 
data that has been cut or copied from Windows applications. This 
data can be pasted from the Clipboard to other Windows applications. 
The Clipboard can contain only one item at a time. Therefore, each 
time an item is cut or copied, the previous item on the Clipboard is 
lost. The item remains on the Clipboard and can be pasted as many 
times as necessary until it is replaced by another item or until the 
computer is restarted.

combination graph A graph that enables you to plot data using two or more types of 
graphs, for example, using a combination of area and bar plotting in 
one graph.

concept A stand-alone planning tool that enables you to provide a quick 
analysis based on a single planning issue (for example, investment 
leveraging or the cost of living). Concepts consist of tables, reports, 
and graphs that are only used to illustrate an idea and are not 
associated with the clients’ plan. The light bulb icon identifies a 
concept.

credit shelter trust (CST) Credit shelter trusts are also known as bypass trusts, threshold trusts, 
and unified credit trusts. They are irrevocable trusts whose primary 
purpose is to preserve the unified tax credit of the client who 
dies first. 

dialog box A window in which you can enter data or select options.
document A report, graph, or concept.
file cabinet An icon that represents the file where a family's plans are stored along 

with their personal information. Each cabinet represents one family 
file. The client name appears beneath the icon identifying the file.

ILIT See irrevocable life insurance trust.
inactive plan folder An icon that represents an inactive plan. The folder must be selected 

before you can work with its data.
Each distinctly colored folder contains a family’s personal and 
financial data for a specific year.

irrevocable life 
insurance trust (ILIT)

An irrevocable life insurance trust (ILIT) is a trust that is funded, at 
least in part, by a life insurance policy or proceeds. Holding a life 
insurance policy in such a trust may, if properly established, avoid 
federal estate and gift taxes, generation-skipping transfer taxes, and 
probate fees.

irrevocable trust An irrevocable trust is a trust that cannot be revoked or amended once 
the trust has been established. The grantor cannot dissolve the trust, 
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change the beneficiaries, remove assets from the trust, or change the 
terms of the trust. The main advantage to setting up an irrevocable 
trust is that the assets in the trust, including any future appreciation, 
are not included in the gross estate for estate tax purposes.

line graph A graph with a series of lines, each illustrating selected data for a 
specified period.

living trust A living trust is a separate legal entity that can be created to own 
property for a person (for example a house, a boat, or a mutual fund). 
The property can be taken back at any time during the grantor’s 
lifetime. At the grantor’s death, the trustee administers or distributes 
the property according to written instructions. Property owned by a 
living trust is not subject to probate at death.

long-term care Relates to coverage for individuals who have lost the ability to look 
after themselves, and to perform common daily activities.

marital trust A trust used by married couples to minimize estate taxes. Assets that 
are transferred to a marital trust are not taxed until the death of the 
second spouse.

pie graph A graph that plots information by dividing a circle into triangles. Each 
triangle represents specific data in proportion to its percentage of the 
total information illustrated in the graph.

plan The collection of a family’s financial data for a specific year. This 
information is represented by a distinctly colored 
plan folder.

Plan Settings dialog box The dialog box that opens when you select a category from the Data 
menu. It is the main data entry dialog box in NaviPlan Standard.

printer An icon that represents a printer that has been set up in NaviPlan 
Standard. An icon with an illuminated green light represents the 
active printer. Printer icons without green lights represent inactive 
printers.

QTIP See qualified terminable interest property trust.
qualified terminable 
interest property trust 
(QTIP)

A type of marital trust. Because of the unlimited marital deduction, 
assets transferred into the trust are not taxed at the death of the first 
spouse (the grantor). The surviving spouse receives all income from 
the trust for life. The grantor dictates to whom the assets in the trust 
go at the death of the surviving spouse.
QTIPs are often used in combination with credit shelter trusts to make 
full use of the applicable exclusion amounts of both spouses.

stacked area graph A graph that illustrates a specified series of information in layers one 
on top of the other. Each layer provides specific information, and the 
layers taken together create a unit that shows both the individual 
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values and their combined total. Clicking any point on a layer 
identifies the type of information and provides the date and value at 
that point.

stacked bar graph A graph that illustrates a specified series of information in vertical 
bars with the information in layers one on top of the other. Each layer 
provides specific information, and the layers taken together create a 
unit that shows both the individual values and their combined total. 
Clicking any point on a layer identifies the type of information and 
provides the date and value at that point.

stacked line graph A graph that illustrates a specified series of information in horizontal 
lines one on top of the other. Each line provides specific information 
that taken together create a unit that shows both the individual values 
and their combined total. Clicking any point on a line identifies the 
type of information that line represents and provides the date and 
value at that point.

testamentary trust A trust that is created in a will and that comes into effect at death. 
threshold trust See credit shelter trust.
trash A temporary storage area in NaviPlan Standard where unwanted 

items can be placed. This icon appears on the screen at all times 
during the operation of the program.

UGMA See Uniform Transfers to Minors Act.
unified credit trust (UCT) See credit shelter trust.
Uniform Gifts to Minors 
Act (UGMA)

See Uniform Transfers to Minors Act.

Uniform Transfers to 
Minors Act (UTMA)

This account and the UGMA (Uniform Gifts to Minors Act ) account 
are considered non-qualified assets, and they allow your clients to gift 
money to their dependent(s). These accounts can help fund future 
education costs. You can assign a dependent as the owner of the 
account, with a single adult designated as the custodian of the 
account.

UTMA See Uniform Transfers to Minors Act.
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Index

Numerics
529 plan, definition, 53

A
Active plan folder, definition, 53
Advanced Features Guide, accessing, 1
Area graphs, definition, 53
Asset class weightings, definition, 53
Asset class weightings, entering, 21
Asset classes, definition, 53
Assumptions

asset classes, 18
entering, 17
general, 17
historical data, 18
inflation, 20
milestones, 18
return rates, 19
risk profile, 18
tax, 18
tax options, 18

Assumptions category, 17

B
Bar graphs, definition, 53
Base plan, definition, 53
Beneficiaries

adding, 14
editing, 14

Buttons
close, 6
compare, 6
context-sensitive Help, 6
file folder, 6
gray and unavailable, 49
maximize, 6
minimize, 6
restore, 6

Bypass trusts, see credit shelter trusts

C
C trusts, see qualified terminable interest 

property trusts
Capital loss carryovers

definition, 53
entering, 18

Category descriptions, 20
Client files

creating, 12
definition, 54

Close button, 6
Closed folder icons, 25
Combination graphs, definition, 54
Compare button, 6
Concept icons, 42
Concepts

definition, 54
printing, 45
using, 42

Conventions, 1
Credit shelter trusts, definition, 54
CSTs, see credit shelter trusts

D
Data entry, returning to, 50
Demonstrations, viewing, 2
Desktop, using, 6
Dialog box, definition, 54
Disability insurance, analyzing needs, 27
Documents

creating, 39
definition, 54
deleting, 8
editing, 50
printing, 45
printing multiple, 46
updating, 44

E
Edit, 14
Estate planning scenarios, creating, 34
Existing trusts, entering, 30
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F
Family member

deleting, 14
Family members

adding, 14
editing, 14
removing, 14

File cabinet
definition, 54
empty, 49
icons, 7
retrieving plans, 7
storing plans, 8
viewing contents, 7

File folder button, 6
Financial planner information, editing, 14

G
Generate Report icons, 40
Goals, analyzing, 27
Graphs

area, definition, 53
bar, definition, 53
changing viewing options, 41
combination, definition, 54
creating, 40
icons, 40
line, definition, 55
pie, definition, 55
printing, 45
stacked area, definition, 55
stacked bar, definition, 56
stacked line, definition, 56
updating, 44

H
Help, accessing, 2
Hints, accessing, 2

I
ILIT, see irrevocable life insurance trusts
Inactive plan folder icon, definition, 54
Insurance, analyzing needs, 27
Irrevocable life insurance trusts

definition, 54
Irrevocable trusts, definition, 54

K
Keyboard references, format, 1

L
Life insurance

analyzing needs, 27
entering policies, 24

Light bulb icons, 42
Line graphs, definition, 55
Living trusts, definition, 55
Long-term care

analyzing needs, 27
definition, 55
entering insurance policies, 24

M
Maximize button, 6
Menu bar, using, 6
Menu items, unavailable, 49
Minimize button, 6

N
NaviPlan Web site, accessing, 2

O
Open folders, 25
Overhead projector icons, 43

P
Pie graphs, definition, 55
Plan Settings

Assets, 21
Expenses, 20
Goals, 22
Incomes, 20
Insurance & Estate Planning, 23
Loans, 21
Planning Assistant, 24
Strategies, 21

Plan Settings dialog box
definition, 55
opening, 17

Plans
activating, 25
definition, 55
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deleting, 8, 26
duplicating, 26

Presentation icons, 43
Presentations

exiting, 43
generating, 43
printing, 44
viewing, 43

Printer dialog box, opening, 46
Printer icons, 45, 55
Printers

adding and removing, 46
no icon on desktop, 49

Professional Advisors, editing, 14

Q
QTIP, see qualified terminable interest property 

trusts
Qualified plans, 21
Qualified terminable interest property trusts, 

definition, 55
Questions

incorrect printout, 51
no plans in filing cabinet, 49
no printer icon, 49
unavailable menu items, 49

R
Report icons, 39
Reports

creating, 39
printing, 45
updating, 44
using the Generate Report icon, 40

Restore button, 6

S
Scales button, 6
Social Security, 20
Stacked area graphs, definition, 55

Stacked bar graphs, definition, 56
Stacked line graphs, definition, 56
Status bar, using, 7
System menu, using, 5

T
Technical support, contacting, 2
Threshold trusts, see credit shelter trusts
Title bar, definition, 5
Trash

changing capacity, 10
definition, 56
emptying, 10
opening window, 8
placing an item in, 9
removing items, 9
viewing contents, 8

Trash can icons, 8
Troubleshooting

copying document to another Windows 
application, 51

editing documents, 50
empty file cabinet, 49
gray and unavailable buttons, 49
no printer on desktop, 49
partial print, 51
prints incorrectly, 51
returning to data entry, 50
won’t print, 51

U
UCTs, see credit shelter trusts
Unavailable buttons, 49
Unified credit trusts, see credit shelter trusts
UTMA/UGMA account, definition, 21, 56

W
Window control buttons, 6
Windows skills needed, 3
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Feedback
Feedback
In order to better suit the NaviPlan Standard Basic Features Guide to your needs, we need your 
feedback. Please answer the questions on this page, and then cut it out and send it to the Technical 
Communications department at EISI.
Mailing address: EISI
Technical Communications Department
500-330 St. Mary Avenue
Winnipeg, MB  R3C 3Z5
Canada
Fax:(204) 942-5100

1. How would you characterize your computer skills (please circle your answer)?
Beginner --- Intermediate --- Advanced --- Professional

2. How long have you been using NaviPlan Standard?

3. How would you rate the overall quality of this guide (please circle your answer)?
1 (low) --- 2 --- 3 --- 4 --- 5 --- 6 --- 7 (high)

4. What do you like about this guide?

5. What do you dislike about this guide?
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6. Are there any changes you would like to see made to this guide? If yes, what are they?

7. Are there any other words or phrases you would like to see in the glossary? If yes, what are they?

8. Do you have any other comments or suggestions?
62


	Table of Contents
	Chapter 1: Using this guide
	Conventions used in the Basic Features Guide
	Finding more information
	Essential Windows skills

	Chapter 2: Navigating in NaviPlan Standard
	What is the title bar?
	Using the menu bar
	Using the desktop
	Using the status bar
	Using the file cabinet
	Using the trash

	Chapter 3: Creating client files and plans
	Collecting client information
	Setting defaults
	Creating a client file
	Editing client information
	Creating a base plan
	Entering plan assumptions
	Entering financial information
	Using plans

	Chapter 4: Analyzing plans
	Analyzing goals
	Analyzing personal insurance needs

	Chapter 5: Estate planning
	Entering estate planning assumptions
	Entering existing estate planning data
	Reviewing the existing estate plan
	Implementing new estate planning strategies

	Chapter 6: Using documents
	Creating documents
	Updating documents
	Printing documents

	Chapter 7: Frequently asked questions
	Questions about NaviPlan Standard
	Questions about plans
	Questions about documents
	NaviPlan Standard - Extended conversion

	Glossary
	Index
	Feedback

